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Welcome to the eleventh edition of my Final Cut Pro newsletter!

My apologies for the delay in this issue. The November issue never 
published and December is much more delayed that usual. My only 
excuse is that life got really busy. Thanks for your patience -- I hope 
the contents of this issue make up for the delay. This is the longest 
newsletter I've published, consider it my present to you for the 
holidays....

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes around the 
middle of each month. Past issues are not archived, however, key articles 
are posted to my website for your future reference. Unless otherwise noted, 
all references are to Final Cut Pro HD, and are not guaranteed to work under 
any other version.

Also, please invite your friends to visit my web site -- www.larryjordan.biz. 
We are working to make it a great Final Cut resource!

Newsletter Contents

●     Larry's "Hands-on Training to Final Cut Pro HD" book is finally available!
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●     OS Update Issues #1: ATTO UL4D and G-5's
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●     Tips from the Classroom
●     Tech Alert - Exporting to Compressor
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●     Technique: Opening Final Cut's Help Files Using Preview
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Ta-DAH!! 
Larry's "Hands-on Training for Final Cut Pro HD" book 
is now available.
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Sigh... and it's beautiful. I got my first copy two days before Christmas. I am 
very, very proud of it and I'm looking forward to your comments. (Um, just be 
gentle. It's my first book and my feelings are easily hurt.)

Here's the book cover, in PDF form, (308K) if you want to see it. And, if you want 
to look over the Table of Contents, click here.

Even better, you can buy it now via Amazon.com, (soon you'll be able to buy it on 
my website). I've been told the book will be stocked in most major bookstore, i.e. 
Borders, Waldenbooks and where ever great books are sold. Here's the link for 
Amazon.com:

http://www.amazon.com/exec/obidos/tg/detail/-/0321293991/qid=1103864136/sr=8-
11/ref=sr_8_xs_ap_i11_xgl14/103-0474113-6708656?v=glance&s=books&n=507846

[ go to top ]

Survey -- Cities for Larry's FCP Master Class

I am delighted to announce a partnership with Lynda.com (www.lynda.com) to 
bring my Final Cut Pro HD Master Class to a city near you. Except, um, we aren't 
quite sure what city is near you. So, please take this month's survey to help us 
plan our Road-trip. We've been working on this a while now -- expect a whole lot 
more details in next month's newsletter

Here's the link -- please take a minute to pick up to three cities -- with luck, we 
can visit one of the cities you've picked:

[ go to top ]

Technique: Capturing from a Panasonic DVX100A camera

I was involved in a discussion recently about the best way to capture from a 
DVX100 camera. Noah Kadner, one of the forum administrators on 2-pop 
generously shared his experience with capturing from this camera. 

(By the way, you can check out his indie movie website, which features this 
camera, here: http://www.formosamovie.com).

Noah writes:

Just got a note from one of our users at 2-pop saying he had spoken 
to you regarding capturing 24p Advanced DVX100 footage in FCP and 
you had advised him to capture at 23.98 FPS. That's not the right way 
to do it. 

I'll give you a quick background on me. I wrote the very first review of 
the DVX100 and it's use with FCP back in November 2002 and have 
been advising people on 2-pop on its use for the past two years. I've 
also worked directly with Jan Crittenden, the DVX100 and SDX900 
national product manager for Panasonic during the past two NABs. So 
hopefully you'll dig my credentials in regard to FCP and the DVX100. :)

DVX100 24pA footage should always be captured at 29.97 because 
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that's what's on the tape. When a user wants to cut at 23.98 they 
need to properly remove the 2:3:3:2 pulldown introduced by the 
DVX100 during filming. The DVX100 flags these extra frames and 
embeds these flags into the Firewire data stream. FCP can read these 
flags back during ingest and conform the 29.97 pulldown footage back 
to the 23.98 captured by the camera. That is what the Remove 
Advance Pulldown from 2:3:3:2 sources checkbox in the capture 
settings is for. But in order to do this properly, the FPS setting in FCP 
must be set at 29.97 to give FCP the full firewire data stream and 
allow it to properly recognize the flags and remove the Advance 
pulldown frames.

If you set the capture FPS at 23.98, FCP will randomly delete frames 
to get from 29.97 to 23.98 but they will not be the correct frames. 
You'll wind up with a 23.98 file that looks odd during playback from 
FCP because the 2:3:3:2 interlaced pulldown frames are still there 
along with randomly missing progressive frames. This has become the 
number one issue plaguing FCP users with DVX100 footage who want 
to cut at 23.98 and has resulted in a lot of confusion. I've hoped to 
lobby Apple on this issue so that they might include a warning pop-up 
in FCP giving notice that 23.98 FPS capture will result in improperly 
digitized DVX100 footage but haven't made any headway and 
Panasonic hasn't been able to either- maybe you can help with that.

I know it seems counterintuitive that one would use 29.97 as the 
capture frame rate in order to ingest 23.98 footage but that's how it 
must be done because of the way the format is recorded to tape. And 
FYI- there are very few tape formats that run at 23.98 natively so it 
would be not be a proper FPS setting for most "24p" formats. The only 
ones I know of that actually can record to tape at 23.98 without 
introducing a pulldown are D5 and Sony HDCAM and HDCAM-SR. If 
you'd like, I can put you in touch with Jan Crittenden from Panasonic 
and she can give you more information on how the process works so 
that you can help spread the word on the proper settings to FCP/
DVX100 users you consult with. Let me know.

Larry replies: I stand corrected and very much appreciate your letting me know 
the right way to capture DVX100a footage.

[ go to top ]

Technique: Changing Column Names in the Browser

This technique grew out of a question Joel Kitay asked:

I used Avid for 7 years and now am 6 months into FCP.  I do a lot of 
sports work. In the Avid, I could custom create columns in my clip bin 
for “name” “play” “quarter,” etc., and sift all those fields.  So, for 
instance, if I was looking for all the “passing” plays in the 3rd quarter 
of a football game, I could sift the bin down to that.  

This leads to 2 questions for FCP that I can’t figure out: 

1.  Can you create custom data fields in a bin?
2.  Can you then sift these columns by keywords?

His question started me investigating, and here's what I discovered -- the answer 
is yes, to both questions.



You CAN rename column headings in the Browser, provided they have the word, 
"Comment" somewhere in the heading. There are six columns that meet this 
criteria:

●     Master Comment 1
●     Master Comment 2
●     Comment A
●     Comment B
●     Master Comment 3
●     Master Comment 4

The first four are easy to find, just scroll right across the Browser and you'll find 
them way over on the right side.

But where, you ask, are the columns for Master Comment 3 & 4? 

Well, they are not displayed in the Browser, but if you hold down the Control key 
and click on any column header in the Browser EXCEPT the Name column, you'll 
see a listing of 16 columns that the Browser is tracking, but not displaying. 

You can select and display Master Comment 3 or 4 from this list.

To change a column name, control click on the column header -- in this case, I 
decided to change the name of "Master Comment 2" -- and select the second 
option -- "Edit Column Name."

Then, double click in the name itself to select it and type your own name. Press 
Enter (or Return) to lock the name in.



As for finding information, go to Edit > Find, and select the column, or columns, 
you want to look in. Type the words or phrases you want to find and Final Cut will 
display all the clips that match your criteria.

There is one "gotcha," however. You need to remember the original name of the 
column when you go to Edit > Find to look for material you've stored in this 
column. The column header may have changed in the Browser, but the name 
displayed in the Find pop-up list is still the original name. 

[ go to top ]

OS Update Issues #1 -- For ATTO SCSI users

After conversations with ATTO Tech support, I warned in a recent issue that there 
might be a problem installing the ATTO UL-4D SCSI card in a 2.5 GHz dual G-5. 
Since then, I've had further discussions with ATTO and it seems that the UL-4D is 
fully compatible with the G-5. Be sure your are running the latest UL-4D firmware 
(1.4.2.f1) and SCSI drivers (3.20).

However, the slot in which you install the card in your G-5 makes a difference, 
depending upon which capture card you are using, so be sure to read your 
installation instructions carefully.

To learn which drivers you are running, select Blue Apple > About This Mac, 
then click More Info.

Click PCI/AGP cards in the left panel, then select your SCSI card. The firmware 
version will be listed in the bottom pane as "ROM version."

Click Software > Extensions and look for ATTOExpressPCIPlus (or, sometimes, 
ATTOSCSI). The driver version will be listed in the Version column.

If your versions are out-of-date, contact a Mac technician for an update. (If you 
try to contact ATTO directly, be prepared for a very, VERY long wait.)

[ go to top ]

OS Update Issues #2 -- 10.3.7 Update Issues

Recently, whenever Apple issues a new OS upgrade, I've taken to contacting all 
my clients to recommend they NOT upgrade until a few weeks pass and we see 
what the results of the new software version are. Here's a summary, for those of 
you taking notes.



●     If you are on a G-4 and you don't need run Motion, stay with 10.3.4.
●     If you are on a G-4 and you need to run Motion, upgrade to 10.3.7 -- 

HOWEVER, things will break, see below.
●     If you are on a G-5 and you don't need to run Motion, stay with 10.3.4.
●     If you are on a G-5, and you need to run Motion, upgrade to 10.3.7 -- 

HOWEVER, things will break, see below.

Things That Break in 10.3.7

RAID systems. Most RAIDs will require a firmware update sometime during all 
your upgrading of OS X 10.3.x. Medea drives have been especially hard hit. 
However, all RAID drives have required firmware upgrades during all the OS 10.3 
updates, including Apple's XServe and Huge. If everything is working great, 
LEAVE IT ALONE. If you are starting to see drive performance drop, or more 
dropped frames than usual, you probably need a firmware upgrade.

Contact your RAID vendor for more information.

The new Apple XServe RAIDs (with 400GB hard drives) REQUIRE 10.3.7 in order 
to run. (I've discovered this gotcha personally.) You can't mount the drives on 
the desktop with any other OS version.

However, Cinewave has been badly hit by all the OS upgrades. Cinewave will not 
work under OS X 10.3.7. The latest supported OS for Cinewave is 10.3.6. Here 
are the specifics:

●     OS X 10.3.4 or earlier -- use Cinewave driver 4.5
●     OS X 10.3.5 -- use Cinewave driver 4.6
●     OS X 10.3.6 -- use Cinewave driver 4.7
●     OS X 10.3.7 -- Cinewave is still in testing and we won't know until mid-

January whether driver 4.7 works reliably or not

My recommendation is if you are running Cinewave stay with OS X 10.3.4.

I've just checked the websites for AJA and Blackmagic Design regarding support 
for OS X 10.3.7. AJA has nothing posted regarding problems with OS X 10.3.7. 
Blackmagic Design recommends 10.3.4 for it's cards, but says nothing about 
10.3.7.

Again, my recommendation for these two cards is to stay with 10.3.4, unless you 
need to use the latest version of the XServe RAID, in which case you are forced 
to upgrade to 10.3.7.

Motion requires OS 10.3.5. However, I've seen a number of G-4 users have 
problems with OS 10.3.5. If you don't need Motion, stay with 10.3.4. If you must 
run Motion, upgrade to 10.3.7 -- BUT, backup all essential data on your boot 
drive before upgrading. Also, Motion is filled with it's own "quirks." While this 
application holds tremendous potential to be wonderful in the future, keep your 
eyes open for upgrades -- they are needed. The current version of Motion is 1.0.1.

Also on the Motion front, OS 10.3.6 broke at least one of the Generators in 
Motion; the Cellular generator. Upgrading to 10.3.7 fixes this problem.

Let me know if you encounter problems and I'll pass the information on.

[ go to top ]

Article: Trade-offs to Consider when Using DV for Professional Work



[Update comment: Hoo, boy! I didn't mean to offend anyone, but already Graeme 
Nattress and Philip Hodgetts have taken umbrage at some of my comments. Their 
comments are reflected in the body of this article.]

This article grew out of an idea suggested by King Dexter, a student and long-
time reader. King writes:

Many, many FCP users are independent small-fries with hand-to-
mouth budgets and limited networks for resources and exposure. 
Many very creative artists must necessarily work with the lower end 
formats such as MiniDV. Most recognize there are pros & con's and 
understand that there are pitfalls to beware of when working in say, 
mini format. I've seen some great disappointments surface with 
regard to expectations that don't come to fruition due to ignorance of 
format-specific limitations. Is there a way that you might list 
obstacles, pitfalls, limitations, etc. that one might want to be aware of 
when beginning a project using less than high-end DV? It's not that 
this kind of information is not available, but man do you have to 
search high and low and in all the crevasses to find it. How nice if 
there could be a Larry Jordan 1-10 (or 20, or 30) check list and 
comparison to consider when ramping up to create in low-end DV. 
Hopefully this kind of information would inform and encourage rather 
than discourage those who, for whatever reasons, must choose to 
work with less than multi-gazillion dollar cameras.

Larry replies: While this list, comparing the benefits of "professional" standard 
definition video formats (such as Digibeta or Betacam SP) with DV could be quite 
long, for me, it boils down into four main trade-offs:

1.  Color
2.  Clarity or apparent focus
3.  Highlight and shadow detail
4.  White levels

Color

DV uses a very compressed and restricted system for displaying colors, which is 
called 4:1:1. (Click here to read an article explaining this in more detail.) In 
summary, what this means is that in DV the color for 4 pixels is described using a 
single number. A computer creates fully uncompressed (i.e. 4:4:4) color. 
However, as Graeme Nattress points out, "There is no fully uncompressed 4:4:4 
SD tape format. All broadcast tape formats, DVCpro50, Digital Betacam are 
4:2:2. This means that DV contains half the color resolution of SD."

Philip Hodgetts adds:

This is somewhat misleading or incomplete.

To clarify: the numbers 4:4:4 are the ratio of [the] sample of the YUV 
color channels within the datastream. Graeme is correct that there is 
no tape format that records 4 U and 4 V samples for every Y sample 
recorded.

What I think you meant to convey in that last sentence is that "...DV 
contains half the color resolution of professional standard definition 
formats". DV has only 1/4 the color resolution of the luminance 
resolution of any SD format. In 4:2:2 Y = 720 x 480 (or 486); U & V 
are 360 x 240 each; in 4:1:1 Y is still 720 x 480 but U & V are only 
180 x 120 each but offset so that they "fill in" a bit for each other.

Not a big thing, and the general principle is right, it's just me being 

http://www.larryjordan.biz/articles/lj_compress.html


picky. :)

(Larry again.) For this reason, if your program involves a lot of chroma-key 
compositing, meaning blue or green-screen work, or lots of color correction or 
color tinting, there just isn't the color information in your signal that exists at 
higher quality levels, such as Betacam SP, DigiBeta or DVCPRO-50. All these 
professional formats work in a color space where, in general, colors are averaged 
across 2 pixels, rather than across 4. While still not ideal, these formats provide 
four times the color information when compared to a DV signal.

Clarity

DV cameras, in order to reduce costs, use smaller chips to convert the image 
from the lens into a digital signal, than a professional camera. In a DV 
environment, a Sony PD-150 camera, which costs around $3,000, for instance, 
uses three 1/3 inch chip to convert light to digital signals; some DV cameras only 
have a single imaging chip. At the high end, a Sony DVW709 Digibeta camera, 
which costs around $45,000, uses 2/3 inch chips. The larger the chip, the better 
able the camera is to resolve the image.

Second, the optics the lens uses are far less able to sharply define the image. 
Good lenses are really, REALLY expensive -- for good reason, they make your 
image look great. A DV camera can show that your talent has hair. A good 
Betacam camera can show the flow and texture of the hair. A good HD camera 
will show individual strands of hair. Good lenses, which can cost tens of 
thousands of dollars, make this possible.

Finally, the auto-focus in most DV cameras is laughable. Far too often, when I 
see a DV image, I see that the auto-focus avoided focusing on the talent, but, 
instead, focused on the background. Canon cameras with automatic lenses are 
notorious for this, which is one reason I am not a fan of the XL/1. Where ever 
possible, turn off the auto focus and auto iris when you shoot. This avoids having 
the camera continuously "search" for focus, or "pump" whenever the camera 
pans or someone walks into the shot.

Highlight and Shadow Detail

DV cameras don't have the ability to display a lot of detail in dark areas or light 
area. Dark areas, especially scenes supposed to be at night, tend to get muddy, 
with lots of subtle details lost. In very bright areas, say, curtains covering a 
window, the detail of the curtains gets lost because the light from the window is 
so bright.

This is not necessarily the fault of the DV spec, but more the fault of the imaging 
chip, poor lenses, and general lack of quality components, which is required to 
make a camera that sells for 2-4 thousand dollars. 

This lack of detail in highlights and shadows, is often what gives DV it's traditional 
"video" look.

White Levels

Recording video on a DV camera uses a digital standard for white level. This 
allows the camera to record whites at 109% when measured on the FCP 
waveform monitor (109 IRE to you engineer types). SD cameras, however, only 
record whites at 100%. For this reason, you need to decrease your white levels 
when integrating DV with SD footage. If your ultimate output is DV or DVD, this 
white level adjustment is not a big deal. Compressing your video for DVD will 
automatically clamp the whites at 100%.

However, if you are recording to any form of Beta for ultimate broadcast, this 



white level is a really big deal. Consequently, you need to pay attention to your 
white levels throughout the editing (but not production) process and adjust them 
after the fact.

One Final Comment

Another reason professional video looks so good is that time is taken for good 
lighting. It is impossible to overemphasize the benefits of good lighting in a 
production. Even cheap indie films can be improved by using softer lights and 
bounce cards. But, here are two other tricks that I swear by that can 
immeasurably improve the look of your productions:

1.  Use filters to warm and soften interviews. Experiment with a 1/4 
warm black Promist filter from Tiffen or Schneider. You'll be 
amazed at how it changes the look of your interviews for the 
better.

2.  Use matte make-up on your interviewees. I am a HUGE fan of T-
gel matte makeup. (I think it's by L'Orieal, but I can't seem to 
find it on the web to give you a reference. I buy it at my local 
Robinson's May). This $25 tube of magic makes everyone look 
great. Best of all, as it doesn't add color, guys are willing to use 
it who would never be caught dead in makeup.

DV is a great format and many, many fine productions are made using it. This is 
just a list of what it doesn't do well. If your projects don't require precise color, 
DV will work great. If they do, you may want to look at a different format - a 
good one that FCP handles well is DVCPRO-50. Cameras and decks are less 
expensive than Betacam and image quality is very, very nice.

[ go to top ]

Technique: Changing Audio Levels

One of the neat things about teaching is that I learn something from each class. 
In this case, it's new ways to adjust audio levels.

First, a bit of background. I teach that audio in Final Cut is clip, rather than track, 
based. If you need to change levels, you need to do so one clip at a time -- 
unless you use the Audio Mixer, which allows you to easily adjust levels by simply 
moving the fader to adjust whatever clip is playing currently. 

The mixer has two big benefits

1.  Listening to, and adjusting, audio levels in real-time
2.  Easy switching between setting levels for an entire clip or setting 

audio level keyframes inside a clip

I also teach the idea of checker-boarding your audio. This is where you put all 
clips that contain similar sounds on the same track. For instance:

●     A1 & A2: Sync sound (i.e. your talking head or main actor), generally the 
audio that accompanies the video on V1

●     A3 & A4: Natural sound (i.e. B-roll sound). This audio is from whatever 
pictures illustrate what the talking head is talking about

●     A5 & A6: Wild sound or ambience
●     A7 & A8: Sound effects
●     A9 & A10: Music track 1
●     A11 & a12: Music track 2



Here's an example from my book (Did I mention my book was available? No??? 
Well, then, click here to re-read my lead story!) that illustrates a six track audio 
mix, with sync sound on top and music on the bottom. 

The advantages to checker-boarding your audio are:

1.  It helps you keep your audio clips organized
2.  Placing audio according to a system makes re-editing a project 

easier, because you don't need to spend time figuring out what 
you did

3.  It simplifies mixing, both inside Final Cut and when you take 
your files to a ProTools system

4.  It makes it easy to see where your audio has holes
5.  There's no performance hit in Final Cut to checker-boarding your 

audio.

There's another benefit, which is the purpose of this technique: If you have 
similar audio on the same track, it is possible to change the levels of multiple 
clips at the same time.

Traditionally, I've adjusted the volume of each clip individually. When the audio 
mixer showed up, I used it a lot in demos, but rarely in my personal projects 
(more likely out of laziness than any concerns about the tool). My biggest 
complaint was that I couldn't set a level, or a filter, that would apply to an entire 
track.

Well, I still can't, but this is a neat technique that I've started using more and 
more. Here's how it works:

1.  Put all similar audio on a similar track. For instance, put all your 
talking head audio on A1 and A2.

2.  Then, if you need to change the level of all these clips by a 
similar amount, which is often the case for dialog that is 



recorded at too low a level, select all the clips whose level you 
want to change. 

A good way to do this is to Option-click on the first clip, then 
Shift-Option-click on the last clip. All intervening audio clips will 
be selected.

3.  Go to Modify > Levels and enter the amount of level change 
into the data entry box (a negative number lowers the level, a 
positive number raises it)

4.  Selecting "Relative" adjusts each track’s volume relative to the 
current level. Selecting "Absolute" changes all selected tracks to 
the value indicated next to the slider. In almost all cases, I'm 
making relative adjustments.

This technique doesn't work if you have lots of different clips on the same track, 
as all levels of all selected clips will be adjusted. However, if you checkerboard 
your audio, to keep similar audio on the same track, this technique is both fast 
and effective.

[ go to top ]

Interesting software #1: MovieCal

Walter Tabax brought an interesting piece of freeware to my attention:

I've found a good film/video calculator. It's called MovieCal v1.5 and 
can be found at www.optical-art.de.

It makes a lot of conversions, calculations etc.

Larry replies: Walter, indeed, this is a very nice calculator. Here's a PDF screen 
shot (224K) that illustrates what it does.

The calculator is freeware, so if you need to convert between all things video and 
film, this is definitely worth checking out.

[ go to top ]

Tips from the Classroom: More keyboard shortcuts

Well, I've taught a lot of classes since this newsletter last published. Here are 
new keyboard and mouse shortcuts some of my students discovered:

Student Short-cut What it does

Larry Ctrl + and/or Ctrl - Changes the audio level of a selected clip, or clips

http://www.optical-art.de/MovieCal.html
http://www.larryjordan.biz/goodies/MovieCal_Screen.pdf
http://www.larryjordan.biz/goodies/MovieCal_Screen.pdf


 

Jared Option-drag
Copies the selected clip, or clips, and insert edits where 
dragged

Jared Option-drag, Cmd

Copies and inserts the selected clip, HOWEVER, if you let 
go of Option before releasing the mouse then press and 
hold Command, FCP performs an overwrite edit. VERY 
useful!

Steve Option-Shift-drag
Copies the selected clip, or clips, and insert edits them -- 
and, if you are moving vertically, constrains movement so 
clips don't change in time.

Jessica Control - w
If Timeline is selected, closes the currently open Sequence 
in the Timeline

Tech Alert - Exporting to Compressor

There have been problems reported with audio and video sync drifting when you 
export directly out of Final Cut Pro into Compressor.

These problems can be avoided if you export your sequence from Final Cut using 
File > Export > QuickTime movie. You can make your movie either a "Self-
contained," or a "Reference" movie.

Once you've exported the sequence, open Compressor, drag your movie into 
Compressor and compress it as you would normally.

I've never seen any audio or video drift when using this process.

[ go to top ]

More Interesting software: FCP Rescue

I first mentioned this software a few months ago. Since then, I've been using it 
continuously on my system and am now enthusiastically recommending it to my 
clients. 

First, here's the site where you can download a copy:

http://fcprescue.andersholck.com

Second, I use this free utility to make a backup of my Final Cut preferences, 
which includes Audio/video settings, system settings (including scratch disk 
locations), and all my User preferences. Then, when I need to trash preferences, 
instead of rebuilding everything from scratch, I simply replace the blown 
preferences using FCP Rescue and all my settings are restored.

If you haven't tried this, take a second look. This is especially time-saving if you 
are editing a tape format other than DV.

[ go to top ]

Interesting software #3: Multicam Lite

Thinking of interesting software, Digital Heaven just announced Multicam Lite -- a 
plug-in for Final Cut that allows you to view, switch and build a sequence using 
video from 3 cameras. This is a great utility for anyone doing multi-camera work.

I have not worked with this myself, especially because it doesn't ship until Jan. 

 

http://fcprescue.andersholck.com/


10, 2005, but if multi-camera editing is something you are interested in, here's 
the link:

http://www.digital-heaven.co.uk/indexflash.htm

If you purchase this utility, let me know your experience and I'll share it in a 
future issue.

Technique: Opening Final Cut Pro's Help Files Using Preview

This technique came from a request by Jean Morrow, who wrote:

I'm wondering if you can tell me how to get the Help information in 
Final Cut Pro 4.5 to open in Preview, where I can search it easily, 
rather than in Adobe Acrobat. I'm running OS 10.3.5, so it should 
open in Preview, but it won't. If I knew where to find the file on the 
hard drive I would try opening it from Preview, but I can't locate it. I 
just upgraded to FCP 4.5 from FCP 4.1, but it wasn't opening in 
Preview in 4.1 either.

Larry replies: Jean, switching Final Cut Pro's Help files to open in Preview is easy. 
However, before you start, be sure that Final Cut is not running.

The first way you can do this is to switch ALL PDF files to open with Preview:

1.  Find any PDF file on your hard disk
2.  Click it once to select it
3.  Choose File > Get Info
4.  Twirl down the "Open With..." triangle, if it isn't already
5.  Select "Preview" from the pop-up menu
6.  Click the "Change All" button.

There's a second way, however, if you don't want all PDFs to open with Preview, 
just the FCP help files:

1.  Control-click on Final Cut Pro in your Applications folder

2.  Select "Show Package Contents" from the pop-up menu
3.  Double-click the "Contents" folder to open it
4.  Double-click the "Resources" folder to open it
5.  Double-click the "English.lproj" folder to open it (If you are 

running a different language than English on your system, open 
the folder named after the language you are running)

6.  Double-click the "Final Cut Pro Help" folder to open it
7.  Select all Help files. (In the English version there are five of 

them.)
8.  Get Info (Cmd-i) on these selected files

http://www.digital-heaven.co.uk/indexflash.htm


9.  Twirl down the "Open With..." triangle, if it isn't already
10.  Select "Preview" from the pop-up menu
11.  Close the Get Info box and all windows.

This second technique switches only the files you selected to open in Preview, so 
when you access help in Final Cut Pro, it will use Preview to open the files. 

IMPORTANT CAUTION: The files inside the FCP icon folder, which you access 
using Show Contents are essential to it's operation. Don't touch, move, rename, 
or otherwise mess with any other program files or FCP will most likely stop 
working.

[ go to top ]

Article: Archiving Media -- Hard Disk or Video tape

John Lynn, of Genius DV, and I have been having a lengthy discussion about the 
best way to archive media. John, in an article on his website, argues that the best 
way to archive media is to store it on hard disks. You can read his article here: 

http://www.geniusdv.com/managing-fcp-avid-media.php

The more I thought about this, and discussed it with John, the more I disagreed 
with this point of view. A few months ago, I wrote an article on how to archive 
your FCP projects. You can read it here: 

http://www.larryjordan.biz/articles/lj_archive.html

John gave me the opportunity to write a differing opinion for posting on his 
website and here's what I sent (thank you, John, for permission to reprint this).

- - -

John, I appreciate your comments, but I disagree with them.

I think your advice of using removable hard disks is a good option for short-term 
storage, say, the next two-three years. However, I think it is a seriously flawed 
idea for long-term storage for three reasons:

1.  Technology is built to become obsolete.
2.  The life of a hard disk, in practice, is shorter than the life of a 

video tape
3.  Image and capture technology continues to improve

Technology Becomes Obsolete

This, to me, is the strongest argument. The technology industry is built on the 

http://www.geniusdv.com/managing-fcp-avid-media.php
http://www.larryjordan.biz/articles/lj_archive.html


idea of rapid obsolescence and frequent upgrades. Look in your garage at all the 
old computer equipment you have stored there. How much computer gear do you 
own that is seven years old that you can still plug into your computer and use 
today? Virtually none of it.

Look at the hard disk technologies we've had over the last decade or two:

●     Floppy disk
●     Hard-shell floppy disk
●     Zip drives
●     Syquest drives (remember them? They were THE backup alternative for ad 

agencies worldwide)
●     Serially-connected hard disks
●     Parallel hard disks
●     SCSI 25-pin hard disks
●     SCSI 50-pin hard disks
●     And a whole plethora of tape drives

How many of these systems are currently working on computers? Virtually none.

Technology is good for current and short-term storage. It is not good for long-
term storage.

You could argue that storing your media on DVD or CD provides long-term 
storage. I would agree. I think we will be able to read CDs and DVDs long after 
today's current crop of hard drives bites the dust. But CDs and DVDs hold only a 
fraction of the media that one video tape can hold. Unless you compress your 
media, which then makes editing extremely difficult.

Look, also, at the current storage plans of broadcast stations and networks. They 
use servers to keep current and recent shows on-line. But the archives of CNN, 
arguably one of the largest and most profitable networks, keeps its news archives 
on video tape. Why? Because 20 years from now, they will still be playable.

Video Tapes Last Longer

The life of a properly stored video tape, assuming it is professional-quality and 
not purchased at "Jim-Bob's Cut-Rate Video Tape and Fish Bait Warehouse", is 
well in excess of 20 years.

Current research seems to indicate that the life of a magnetic hard disk is less 
than that.

Image and Capture Technology Continues to Improve

As technology continues to improve, so does its ability to capture, render, edit 
and output images. Recapturing from source tapes allows you to take advantage 
of these improvements. Simply reloading clips already captured locks you into the 
image technology of the past.

Conclusion

I agree with your idea of using removable storage to keep a current project 
available for a while. My disagreement is relying on this system for periods longer 
than five years. Nothing I've seen in technology over the last twenty years leads 
me to believe that hard disk, communication, or media technology is going to 
stand still.

Granted, capturing off video tape, especially cheap video tape, poorly stored and 
poorly cared for, can be a problem. But, I think basing your archiving plans on 
removable hard disk technology is even more of a problem.



- - -

After reading this discussion, one of John's readers, Mickey Hough, wrote back, 
saying:

I currently use all methods both of you mentioned but I would like to 
only work off of hard drives because they are so much faster and 
easier to use. I am not quite sure what Larry is referring to about hard 
drives becoming obsolete? Hard drives have been around forever and 
if formats changed I would sure think that you could just transfer your 
media from the old format to the new? Anyway maybe some more 
input would help. 

I replied: Here's my point:

You can archive on hard disk or on video tape. I suggest video tape is the better 
choice.

1.  Video tape has a longevity of 20-25 years, under proper storage
2.  Video tape is cheaper, by a long shot, than removable hard disks
3.  There is no assurance that a hard disk you use today will be 

compatible with systems you use in 15 years. (Look at SyQuest 
or serial hard drives as classic examples of technology 
obsolescence). Video tape equipment today can be easily 
purchased or rented that will play tapes recorded 20-30 years 
ago.

4.  I just finished teaching a Final Cut class with representatives 
from Fox, CBS and NBC networks. In all cases, they have their 
current video projects stored on hard disk, but for long-term 
archives, they use tape.

Tape is cheaper, more flexible, more likely to work and lasts longer than hard 
disks.

[ go to top ]

Article: How Long Does Video Tape Last?

Archiving your media on video tape begs the larger question -- how long does 
video tape last? 

Last issue, I asked readers with expertise in this area to comment. I gathered 
their responses and put it into a three page article, which you can read here.

http:www.larryjordan.biz/articles/lj_videotape.html

Reader Mail

As you might imagine, not publishing for two months has our mail box WAAY too 
full. Here is a oversized helping of questions and tips.

Caryn writes:

I just read "Technique: Prepping Still Images for Video." I have been 
working with FCP for about 3 years now, mostly using still images. A 
couple of questions about 'prepping still images for video' remain 

http://www.larryjordan.biz/articles/lj_videotape.html
http://www.larryjordan.biz/articles/lj_image_prep.html


unanswered and I thought you may be able to help and that your 
other readers may also be interested. 

First of all, I routinely zoom in a picture (by adjusting the scale in the 
motion tab to around 200), so I am wondering if it is of any value to 
scan at a higher resolution than 72 dpi? Secondly, is there any 
difference in saving files as TIFF vs. PICT images (or is there a better 
option)?

Larry replies: The most important rule to keep in mind about images in Final Cut 
is that FCP doesn't care about dots-per-inch (dpi). All FCP cares about is the total 
number of pixels across by the total number of pixels down. So, when you are 
scanning pictures for video, set your dpi to 72. Then, if you want to zoom in, pan 
across, or tilt up, you'll need to scan your picture with sufficient pixels to allow 
the move.

To help figure out the size you need to scan, Neotron Design (www.neotrondesign.
com) has created a scanning template with all kinds of numbers to help you 
figure this out.

The reason you don't want to simply scan the biggest picture you can, is that FCP 
has several internal limits on the size pictures it will accept. Theoretically, an 
image can not be bigger than 4,000 x 4,000 pixels. However, you'll start to run 
into problems if you build a montage with images that are consistently larger 
than 2,000 x 2,000 pixels.

So, Caryn, in your example, if you want to zoom into a picture to double it's size, 
you'd need to scan your image to be 1440 x 1080 x 72. This will allow you to 
double the size of your image (it's 720 x 540 doubled in both dimensions). Best 
of all, this keeps your image size well below any problem sizes.

As for TIFF vs. PICT, the advantage to the TIFF format is that it can be created on 
both Mac's and PC's. Both PICT's and TIFF's are bit-maps and both can be used 
inside Final Cut.

- - -

Jaspreet Lamba writes:

One particular thing that I am trying to achieve using either FCP, AE, 
Combustion any tool (but preferably FCP), is that have a particular 
subject or object in a moving video clip being in full color where the 
rest of the frame is Black and White.  The similar effect was done in 
film “Pleasantville”.  I have not been able to find any good tutorial or 
help with this particular issue.  I have seen a “still image” tutorial but 
I wanted to do this in a moving video.

Larry replies: You can do this in Final Cut, using the Color Corrector 3-way filter 
and the limit effect. Here's an article that shows you how. 

http://www.larryjordan.biz/articles/lj_limit.html

Keep in mind, however, that you'll need to limit your selection to a single color, 
you can't do this with a range of colors, unless you use a blue/green screen effect

- - -

Maria Garcia writes:

First of all, thank you, thank you, thank you for your kindness in 

http://keyguides-2.home.mindspring.com/Pages/kg_edit.html#fcp
http://keyguides-2.home.mindspring.com/Pages/kg_edit.html#fcp
http://www.larryjordan.biz/articles/lj_limit.html


offering this wonderfully informative newsletter. I read it thoroughly 
and work out all your suggestions as I read. I would, however, like to 
bother you with one question that I cannot seem to get an answer to. 
Is there a way for me to permanently connect a TV monitor to my G5 
so I can view my project in FCP while I edit? If so, please explain.

Larry replies: Assuming you are capturing and editing DV, the easiest way to do 
this is to connect your monitor to your camera or deck, then use Firewire to 
output video from Final Cut to your monitor. Be sure View > External video is set 
to "All Frames" and View > Video playback is set to "Firewire NTSC."

- - -

Ray Close writes:

I have just discovered your 'site and your newsletter.

For some years I have been getting deeper and deeper into the water 
of Video editing for a Christian mission we have been involved with for 
over 30 years. Initially - part-time while I worked an office job - using 
Director 4 and PageMaker, then moving on to iMovie, on again to 
Adobe Premiere.

Early last year I believed I needed to retire from secular work and 
move to the US where our mission head office is located, and become 
fully involved in producing videos of our Pastor's preaching and 
teaching ministry. Here we use FCP, so a new learning process was 
begun.

As we are too far away from professional training facilities (and they 
are usually way beyond our financial reach in terms of cost) I have 
been teaching myself FCP. Past experience with Premiere helped 
greatly, so the process wasn't too frustrating. But it has been help 
with problems and puzzles that I have had to seek outside the 
manuals. I have so much appreciated the help I have had from Ken 
Stone and his discussion forum. Then I was looking further afield - 
LAFCPUG - and came across your links. And I am so grateful I did! My 
printer right now is busy churning out notes I have gleaned from you.

I just want to tell you how much I have already learned just this 
morning already! Thanks from a grateful heart!

Larry replies: Thanks for writing. I appreciate the kind words, and so does 
LAFCPUG and Ken Stone.

- - -

Mark Rosenberg writes:

Love your newsletter!  I am relatively new to FCP HD, former Accom 
Stratasphere editor, and with the learning curve a little higher than 
usual for me, reading your monthly letter has given me several new 
tricks that I am using today.  Thanks!

A story idea for the coming months... any rumors/truths about the 
upcoming NAB 2005 upgrades for FCP HD?  Being from Las Vegas, I'm 
lucky to attend every year and see first hand the latest and greatest 
toys in our ever-changing industry. 

Larry replies: Mark, the most eagerly asked question for all of us is, "What's in 
Final Cut 5?" 



If I knew, I wouldn't be allowed to answer. As I don't know, my only comment is 
that Apple has used NAB every year for the last five years to announce new 
versions of FCP; and, for that matter, Motion. We'll just have to wait and see if 
that tradition holds true this year.

- - -

Dilesh Korya writes:

Been checking out your newsletter for last 6 months and have found it 
very useful. Recommended it to lots of FCP editors. 

Just one point to make: I edit for BBC and Channel 4 in England, 
making docs. Sometimes the project gets to be big, over 40 bins, and 
sequences longer than an hour. Every time I start FCP with this 
project the timeline editing becomes exceedingly sluggish. The only 
way to resolve the problem would be to start a new project each time 
I start up FCP and copy all the bins and seq. over to this new project 
and use this project from now on. And, hey presto, the problem is 
gone. 

The thing is, you have to remember to replace the old proj. with the 
new one, with the same name, otherwise you will end up with lots and 
lots of folders containing your media for each successive project you 
make. You do not need the old proj. once the files are transferred to 
the new one.

Hope this is clear - new project filenames meant I had to do lots of file 
administration after a few days.

It would be very useful to know if other editors had this issue. Many 
editors who work on big stuff like this in Bristol (where I work) have 
this problem, and it is becoming more common as more editors use 
FCP. It only started happening on FCP HD, never before. 

(I am using FCP HD, 1 gig RAM, 500Gig internal Hard drive, all project 
digitized at DV quality onto my internal drive, Mac dual 2 gig G5, with 
deck-link Sp card- so system is in fine order)

Larry replies: Very large sequences require a lot of RAM to be able to load 
properly. The sluggishness could be caused by: 1) insufficient RAM, 2) a 
corrupted project file, 3) bad RAM or other system-level problems.

In your case, try breaking your program into smaller sequences, then combine 
these sequences into one master sequence. A way that works for me is to divide 
my program into Acts (or film into Reels). Each Act, or Reel, is a sequence. When 
it comes time to put the whole show together, I create a new sequence and bring 
all these smaller sequences into it.

Nesting is NOT a good idea if you need to up-res, because FCP often has 
problems creating a batch list when sequences are nested in other sequences. 
However, if you are editing master footage, it works great.

- - -

Michael Meis writes:

I am an FCP editor in Hollywood. I have been reading your newsletters 
since you've started writing them. (I mean really reading them!) I 
have a quick question for you. 



Is there a way to print to paper, a list of markers in the timeline? I 
need the comments for producers and work-orders. 

Larry replies: Michael, as far as I know, there is no way to output marker lists to 
print. On the other hand, I'll open this question to everyone, in case a reader has 
more insight on this than I do.

Update: Both Philip Hodgetts and Andreas Kiel wrote to tell me of a shareware 
utility that does exactly this and much more: XML2Text. The cost is 45 Euros and 
you can learn more by clicking here: www.spherico.com/filmtools/. This site has 
lots of interesting Final Cut utilities and it worth checking out.

More on this next month.

- - -

Richard Warmoth writes:

Really enjoy your tips. I'm currently living in Munich, Germany and I 
just wanted to let you know editing here is done mostly by women. 
Don't know why, that's just how it is.

I do have a question. I also use Pro Tools LE with a M-box. I can't get 
FCP to play out through the box no matter what I do. All computer 
software has the latest versions and updates. G4 mirror door dual 
1ghz with 2GB RAM.

The Core Audio doesn't want to support FCP although I've read that it 
has worked for other people. Any ideas? It's not a big deal but, I 
would like to route all audio outputs the same way so that jumping 
between programs would be easier.

Also for quick audio work I find the two audio fades in FCP too 
limiting. Working with the pen too complicated. Aren't there any FCP 
Plug-ins for audio? A few different kinds of fades would be a good 
start. Guess I'm< spoiled by Pro Tools. There are just instances where 
I could finish in FCP with a little work on the audio side and the 
appropriate functions (or plug-ins) are missing in action.

Larry replies: Thanks for the tip on most German editors being women, this is 
definitely not the case elsewhere, based on the results of last month's survey 
(click here to view the results).

Yes, you can use the mBox with FCP, I'm doing so right now. In order to use the 
mBox you need to do three things:

1.  Go to System Preferences > Audio and set Input and Output to 
DigiDesign hardware.

http://www.spherico.com/filmtools/
http://www.larryjordan.biz/surveys.html


2.  Go to Applications > DigiDesign and run Digi CoreAudio Manager.

3.  Click the HW Setup button.

4.  Make sure you have selected the appropriate input, either 
Analog or SPDIF. In most cases, you'll be using Analog.

5.  Open Final Cut and set View > Audio Playback to Digidesign 
(mBox)

Finally, there are only two audio fades in FCP. FCP is not ProTools, sigh... Most 
Waves plug-ins work -- but not the Waves interface. In FCP you will need to enter 
numbers for each variable. I hope this will change in the next version, whenever 
and whatever that is. ... 

But, again, I'm only guessing. I don't know nothing 'bout the future.

- - -

Michael Ives writes:

Thanks very much for another great newsletter, there are always 



several items brought up that I devour as a relative newcomer to FCP. 
In the section on FCP folders and where they go, you mentioned that 
it's a good idea to have waveforms turned off unless editing audio. 

My question: Is raising/lowering or fading in/fading out considered 
editing of the audio tracks. This is about as fancy as I get and would 
turn the waveforms off if it added to the capabilities of my computer. 
But also, I do export specific video clips into LiveType and Soundtrack 
to synchronize them, does this need waveforms? I have a feeling that 
with my G5 and 2.5Gbs of RAMM I probably don't have a lot to worry 
about but I've grown to love the 'fine tuning' I, as one of those 'Right 
Brain' guys can do with their computer.

I learn so much from short burst of concrete, focused knowledge and 
relevant lessons. i.e. your newsletter. Thanks again for sharing what 
you know.

Larry replies: It takes CPU cycles to display the waveforms on your timeline as 
you are editing. Rather than waste CPU cycles to display that which you are not 
editing (audio waveforms), leave waveforms off until you need to see them to 
edit. You can always adjust clip volumes, or make edits, or add transitions 
without looking at the waveforms. While the benefits will be minor on a dual G-5, 
if you are editing on a G-4 system, turning off the display of waveforms in the 
Timeline (Option-Command-W) will have a significant performance benefit.

- - -

Brian Seegmiller writes:

In reading about using a monitor and not a TV, I have a question. 
Before I got my Mac, I used an Amiga 1200 computer for the longest 
time. It came with a monitor with RCA video/audio in and RGB in to 
hook up to the Amiga. It also has settings for RGB mode (COMP., 
SEP., and RGB) on the front and RGB mode on the back for digital 
positive or negative and Analog. Is this monitor good enough to use 
for checking your image?

Larry replies: In brief, no. As TV sets age, they change color and zoom in so you 
no longer see the entire picture. Worse, they are often very over-saturated. 
These are not good to use when making color judgments. General viewing is OK, 
but not for any kind of serious work.

[ go to top ]

Last Month's Survey

Last month, I was curious about the gender of who my readers are -- and, by 
extension, editors in general. (Yes, I know this is not a random sample and can't 
be generalized to the population at large -- but, I'm going to do it, anyway.)

You can view the results of all prior surveys here.

I was interested that only about 1 in 5 editors that completed the survey were 
women. I would have expected more. On the other hand, Phil Hodgett's wrote in 
to say that on his ProApps website he is seeing similar results: 93% male to 7% 
female.

[ go to top ]

http://www.larryjordan.biz/surveys.html


Predictions for 2005

As I've been writing and researching this issue, three themes keep recurring that 
I think will be significant in 2005. So, just for the record, here are three things 
I'm expecting to write more about in the coming months:

1.  Storage area networks -- Avid has been doing this for a while 
with Unity. Xsan, from Apple, will bring the idea of storage area 
networks to the mainstream of Final Cut users. The question is 
whether it will be simple enough to install and run. This has 
tremendous potential for sharing media data between edit 
stations.

In fact, I've put together a poll to find out how interested you 
are in shared storage for your editing systems. 

2.  Audio in Final Cut -- FCP made great strides from version 3 to 
version 4 in improving it's audio mixing capabilities. But there is 
a lot more that needs to be done. Will version 5 be the version 
that delivers improved audio?

3.  Pro-sumer level HD -- Sony has announced an HDDV cam, JVC is 
shipping one. There are a flock of new codecs that Apple has 
already announced it will support, with H.264 being one most 
frequently mentioned. Will HDDV have the same impact on the 
industry as DV has had?

Let me know what your predictions are and I'll share them next month.

Here's the commercial that supports this newsletter.

I provide system design, consulting, editing, training and support for Final 
Cut Pro, DVD Studio Pro and Motion.

You can review my support and training services here.

If you need training, help or advice with Final Cut Pro or DVD Studio Pro, I'd 
appreciate it if you would give me a call, (818) 879-5105, or send me an 
email -- larry@larryjordan.biz -- worldwide.

My client list speaks for itself.

Your support of my services keeps this newsletter free.

Thanks.

Wrap-up

Well, thanks for making it through the latest issue!

That's it for this edition of the newsletter. Let me know what you think, and tell 
your friends to subscribe. I love reading your comments and sharing them with 
others. That way, we all learn!

http://www.larryjordan.biz/about/services.html
mailto:larry@larryjordan.biz?Subject=Help,%20please!
http://www.larryjordan.biz/about/clients.html


Normally, in this space, I project what I'm going to talk about next month. 
Except, right now, I'm completely clueless. So, send in some ideas of what you'd 
like us to talk about.

In fact, send in some tips of your own. I'm happy to publish everyone's ideas.

Thanks -- and have fun editing!

Larry

Subscribe to Larry's FREE Monthly FCP Newsletter!

Email:     

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to 
sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying 
these ideas.

The opinions expressed in these newsletters are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. All 
trademarks are the property of their respective owners and are mentioned here for 
editorial purposes only.

Text copyright 2004 by Larry Jordan. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without written (or emailed) 
permission from the author. 

Links to my website home page are welcome and don't require prior permission. 
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